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Introduction

The disk manager service enables the manipulation of files and directories on both
local and remote machines from within WISDN. Remember that the disk manager
deals with the remote machine in much the same way as it  deals  with the local
machine. This means that, for example,  copying and transferring files require the
same actions.
.
Differences with File Manager 

The disk manager service is similar to Windows File Manager in terms of the features
that are supported, sorting, display option, rename, delete, etc. The main differences
between the two pieces of software are:

- Drives are included as part of the left hand directory structure rather than as
icons on the caption bar. 

- Duplicate has been added to the system menu to display a second version of
the active directory.  

- One additional include option is the ability to display files on the basis of date. 
- The right hand mouse button can be used to select files for transfer as well as

the Control and Shift key options available with the left hand mouse button. 
- Files can be renamed and/or deleted on the local or remote machine depending

on the files that are displayed and the access rights that are allowed. 
- Copying (see below) 

Copying and transferring files
Once you have dragged the selected items to their destination  letting go of the left



or right mouse button will display the  Copy  dialogue box described in this section.
Remember that What-You-See-is-What-You-Copy, which means that if sub-directories
are included in the selection to be copied, then the Include options currently in force
apply to that sub-directory. Only those files which you would normally see if that sub-
directory was open will be copied.

The source and destination machines can be either local or remote machines. This
means that copying and transferring files are effectively the same thing, but beware
access restrictions may apply on a remote machine.
The left side of the Copy dialogue box gives details of the source files, whilst the right
side shows details of the destination. Between these is the progress meter. Along the
bottom is a message area and the main buttons. 

Status lines
Whilst  copying is  in progress,  the status  lines show the paths and names of  the
source and destination files. If the path is too long, some of the sub-directories will
replaced with dots, for example c:\long\path\file may be shortened to c:\...\file. The
name of  the file being read or  written will  also appear on the status bar  on the
remote machine.
If a problem occurs, the nature of the problem will be indicated in the status lines. It
is not always possible for the disk manager to know the exact problem, so some hints
are usually provided, indicating possible causes.

Disk full
If there is not enough space on the destination disk, a message will be displayed in
the status lines.  Copying can still  be completed using either the  Recopy  or  Retry
buttons, after taking the appropriate action.

More than one copy
When copying is in progress, WISDN and the disk manager service are still able to
carry out other activities, including copying. This means that several  Copy dialogue
boxes can be simultaneously displayed, each actively copying files. This is of limited
use with a  modem  and single  PSTN line.



Automatically ending the call
To automatically end the call  after copying, close all  other windows using the call
when copying has begun, leaving the  Copy  dialogue box as the only window using
the call.
When copying has finished, the Copy dialogue box will automatically be closed. Since
a call is ended when the last window using the call is closed, the call will be ended.
When the call  is ended in this way, the normal confirmation message will  not be
displayed.

Parcels, Automatic and Delayed Transmission

As well as providing an interactive method of viewing,  sending and receiving  files
WISDN provides other methods of transferring files. These methods provide you  with
a range of tools to transfer files that could meet a number  of requirements and
include methods for:

-Setting up an address, 'Post box ', to which files can be dragged and the call will
begin and end automatically.

- Collecting files together in 'Parcels' so that they can be sent or received in a non-
interactive manner.

- Using  the 'Parcel'  as a basis for delayed transmission based on a 'Timer'.
The alternative methods of transferring files all make use of the Parcel phone book.
Selecting the Deferred Transfer Option from the Call  Menu will  display the Parcel
Phone book. 

This dialogue  requires similar details to the Data Call dialogue box for call setup  plus
additional information for the files to be transferred 'parcels' and timer details for 
deferred transfer. 

Automatic Transfer 
Automatic transfer sets up a Window or icon on the desktop. When files are dragged
to the icon WISDN will dial the number, send the files and end the call. 

The only details that must be completed in the Parcel Phonebook are the name and



number as defaults will be provided for all of the other components. After selecting
the name of the remote machine and checking that the detail for  Timer is <Now>
and Parcel File is  <Automatic> then selecting the Send button will close the window
and display an icon.
The title of the icon will include the Name selected from the address book. Files can
be dragged from WISDN or File Manager to the icon. When files are dropped on to the
icon then WISDN will make a data call to the number associated with it and send the
files. Other files can be dragged to the icon while the call is in progress and the call
will  continue  as  long  as  the  there  are  files  to  send.  The  call  will  be  ended
automatically when there are no files left to send.

The phonebox icon can be closed by bringing up the system menu by clicking on the
icon and chosing the Close  option. The phonebox  icon can be also restored to a
Window which  displays information about the deferred transfer and can be used to
edit the details associated with it.  The Window will be displayed either as a simple
window with two buttons and a display area, or a more complicated window with all
the information on the automatic transfer. These can be switched by using the Show
details and  hide details  button

Parcels
In developing delayed transmission for WISDN the concept of a parcel has been used.
File names are collected together to form 'parcels' which are stored to await transfer.
A parcel is simply a text file, usually with the extension .PAR, which lists the files to
be transferred. The parcel can be stored on either the local or remote computer and
the files can be either received or sent. Each parcel has  a timer associated with it. 

Creating and editing a Parcel.
In order to use delayed transmission it is necessary to create a list of files or 'parcel'.
To do this select the Copy (F8)  menu option  from  the File menu or press the F8 key.
This will  display the Parcel Window . If files had been selected before the copy button
is pressed then these files will  be included in the Parcel  when it is opened. If  no
selection had been made then the parcel will be empty. 

There are two methods of adding to the list of files in a parcel. One of the important
considerations in developing the Parcel utility was that the parcel can contain files
which  do  not  exist  when  the  parcel  is  created,  but  will  exist  at  the  time  of
transmission. 
Method 1: Select and Drag - Parcel supports the dragging of files and directories from
WISDN and Windows File  Manager.   If  the  selection includes  a  directory  the  Add
Directory dialogue box will be displayed.
Method 2: Using the Edit Fields -Select and drag provides a mechanism for quickly
building up a list of files in the parcel.  The Path and Files Edit Fields   provide a
mechanism for fine tuning the contents of a parcel.
Individual files can be added to the list by typing in the details. These files do not
have to exist when entered. The wildcard characters '*' and '?' can be used as part of
the file name to provide a template for files to be included at the time of transfer.
This makes it possible for more than one template to be  used in the same parcel. So,
for  example,  various  different  types  of  data  files  can  be  included  without  the
executable programs.

Removing files from the parcel
To remove an individual file name from the parcel, select the file in the parcel's File
display window and press the Delete key on the keyboard or select Remove file(s) in
the Edit menu. The file name will be removed from the parcel. Any directories left



empty by this action will be removed from the tree display.
To remove all files in a given directory from the parcel, select the directory in the
parcel's  tree display window and press the Delete key on the keyboard or  select
Remove directory in the Edit menu.

Managing Parcel Files
Once the details of a parcel are correct they can be saved to disk using the Save or
Save As  options from the File menu. If a the parcel needs changing or updating it can
be reloaded from disk. To do this select the Open option from the File menu to display
a standard Open File  dialogue box (similar  to that of  Save As).  To close any one
parcel, first of all select the parcel window to close and then select Close from the
system menu attached to the parcel window caption bar or use the function key Ctrl
+ F4. If the parcel has been altered since it was last saved then a warning will appear
and appropriate action will need to be taken. 

Transferring Files using Parcels
It is not necessary to save the list of files in the parcel before sending them. Selecting
Transfer Button, without saving the Parcel File will display the Parcel phone book with
the details of the list included and create a temporary file name that will be displayed
in the Parcel File field. If a Parcel had been loaded or a new parcel saved then the
details of the Parcel would be contained in the Parcel  File   of the Parcel phone book.
After selecting the name of  the remote machine and checking that the detail  for
Timer is '<Now>'  then selecting the Send button will close the window, attempt to
set  up the  call,  transfer  the  files  on connection and end the call  on completion.
Details will be saved to the transfer log in line with the current settings.  

Files  can be received from the remote machine if  the  details  of  the transfer are
changed using the Timer Details Window.. If they are changed to receive the list of
files rather than send them then the Send  Button will change to a Receive Button. 

Deferred  Transfer 
In order for a deferred transfer to take place the name of a  parcel and timer need to
be selected. you should also check that if the remote site expects a password then
the .option has been set in the Security dialogue box.  

Choosing a Parcel
The Parcel file list  contains details of the most recently changed parcels and the
parcel to be sent can be chosen from this list. If the required Parcel is not in this list
then selecting the <select parcel> option in the Parcel file list will display a standard
dialogue box. The default for the file extension will be .PAR.  

Setting the Timer 
The Timer is an important feature of the delayed transmission  because it contains
not only the time and date information and the remote site details but also additional
details  relating  to  the  delayed  transfer.   A  number  of  standard  timers  can  be
produced by giving each its own name and  details. A parcel can be associated with
more than one timer making it possible to send the same data to different sites.  The
normal default is '<Now>' as this is used for immediate copying. A new Timer name
can be typed directly over the top of the '<Now>' timer. Selecting the '<New Timer>'
will clear the field and also allow a new timer name to be entered. 
Selecting the Time.. Button  then displays a dialogue box that allows the time, date
and frequency information for a specified  timer to be edited. 

The other details  for  a deferred transfer,  the number of  retries and the duration



between retries are set in the Data Call Options dialogue box. The current values of
these two parameters at the time of   transfer will be used.   

<Automatic > Icons and Timers
Automatic Icons  can be associated with timers  in the same way that any named
parcel can, but  the timer details cannot be set.  Instead the timer acts as a flag to
indicate that icon is to be started each time the WISDN software is started.  Unlike
with the <Now>  timer which will be removed when WISDN is closed.

Removing a Timer
An existing timer can be removed by selecting the timer to remove and pressing the
Remove Button in the Parcel  phone book. The <Now>  and <new Timer> timers
cannot be removed. 

Viewing a Timer

Timers that  use a named parcel (not automatic) and are not Once only can be 
viewed by selecting the Timer button from the Parcel phonebook dialogue box. This 
will display a dialogue box with the following information. 

Name , Type, Date : these are  both a heading and a button. As  headings headings
they indicate the type of information shown in the table below the heading. When 
pressed the order the table is sorted in will be by the type of information chosen.  
Show Details/Hide Details this button is used to increase or decrease the size of the
dialogue box to show or hide the details of the timer and the parcel associated with 
it. 
Select timer Selects the timer, adds it to the timer edit field of the parcel 
phonebook and closes the dialogue box. 
Cancel closes the dialogue box without making any changes to the  timers. 

'Once only' timers are deleted from the list of timers once they have been used. If 
WISDN was not active when the timer expired, it will be removed and not activated. 

Changing the Timer details
Normally the requirement will be to send files from  the local computer using a parcel
stored on the local computer. This is the default for all new timers and a requirement
for automatic transfers. However, it is also possible to receive files from the remote
machine or use a parcel list on the remote machine. This allows  a number of flexible
combinations to be made for delayed  transfer. Selecting the Timer Details button will
display the details that are associated with the timer.

When WISDN is first run there are a standard set of defaults for the first timer that is
created. Some of these default details  are also used in all subsequent timers until
explicitly changed while for others the defaults used will  be the same as the last
timer used. These defaults are summarised in the table. 

Overwrite Transfer Log last setting,  initially Overwrite is on
Transfer log name last used , initially WISDN.TRL
Send/Receive Always defaults to Send
Local/Remote Always Local
Time Always <Now>

The Transfer 
Once  the  details  of  time  and  transfer  requirements  have  been  entered  the



transmission of parcels occurs automatically. It is important that the remote and local
machines  have  been  set  up  so  that  automatic  answering  is  allowed  and  the
appropriate security has been allocated. For example, if the parcel is stored on the
remote machine then the local machine needs to have both read and write access to
the remote machine. 

At the selected time WISDN will attempt to connect with the remote machine and
display the Parcel icon on the screen.

If there are no problems WISDN will transfer the files in the parcel to the required
destination. Any directories which are required will be created and existing files are
overwritten.  The Parcel  icon  can be restored to  a  Window.  This  Window displays
information about the current file transfer. If there is no current activity then nothing
is  displayed.  Details  of  every  transfer  are  written to  the  log  file  specified in  the
Details  dialogue box.

If a transfer is timed to start whilst a previous transfer is still in progress, it will be
rescheduled to take place soon after the active transfer has finished. If there is a
problem making the call (e.g. if the line is engaged), WISDN will try the call again
after the time  set in the phone options, and up to value set as the maximum number
of  retries. If after the maximum number of retries the call has still not connected  the
transfer is abandoned. Problems transferring individual files will be logged in the log
file, but there will be no further attempts  to transfer the file.

The log file
Each time a deferred or automatic transfer takes place, the chosen log file will be
updated. If the log file exists, the new entries will be written after or over the existing
entries, depending on the status of the Overwrite Checkbox. Each log gives the date
and  time  when  the  telephone  number  was  dialled,  the  telephone  number,  an
indication of whether the call was successful and the transfer details. The name of
each file transferred is also written to the log. If successful, the file name is preceded
by spaces, otherwise two asterisks precede the name and the following line describes
the problem. The message is preceded by an arrow (the caret character ^) as a
reminder that the problem occurred in the file given on the previous line. If the parcel
is on the remote machine, the first file transfer will be when the log file is copied to
the local machine.

In order to view the Transfer Log, select  the Transfer Log option of the Options Menu
item of the main application. This will display a dialogue box to open a transfer log.
The default file will be the most recently used log. Selecting a log file and opening it
will open Windows notepad and display the transfer log details. 

The sample  log shown below includes entries  for  a  call  without  a  parcel,  with  a
temporary parcel and with a named parcel, as well as a failed transfer. 

Deferred transfer log Wed Jul 06 09:50:16 1994 
  Dialling 760813
  Call established.
  C:\WISDN14\ICON1.BMP
  Deferred transfer complete Wed Jul 06 09:50:20 1994 

Deferred transfer log Wed Jul 06 11:28:37 1994 
  Dialling 071713 5070
  Call established.



  Opened parcel : C:\WISDN14\HELP\TEMP.PAR
  C:\WISDN14\SLIDE02.BMP
  C:\WISDN14\SLIDE03.BMP
  C:\WISDN14\SLIDE16.BMP
  Deferred transfer complete Wed Jul 06 11:29:25 1994 

Deferred transfer log Thu Jul 21 14:27:09 1994 
  Dialling 760813
** The call ended before it was answered.

Where there are filenames with  no path name specified  (not shown) the destination
directory is the shared directory specified by the receiving machine. 


